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Basic Features, Requirements, and Installation

FmView is a Explorer and File Manager add-on. It can display the contents of the currently
selected file. It automatically determines the file format and selects an appropriate
representation.

FmView works with Explorer for Window 95 and NT 4.0 as well as under File Manager for
Windows 95, Windows 3.1x, Windows NT 3.51 and NT 4.0.

Features
Here are some of the 70 representations that have been implemented so far:

* ASCII text

* ANSI text

* Hex

* WRI Write files

* DOC MS WinWord

* DOS Word

* BMP & PCX bitmaps

* WMF Windows meta files

*1CO, DLL, EXE icons

* DLL, EXE headers

* OB] files

* ARJ, LZH & ZIP archives directories

* Graphics formats JPG, GIF, TIF, TGA, DCX, EPS, WPG, PCT (You must be registered).
* FXD, FXR WinFax

* XLS Excel 4

* DB, MDB, PDX ... Database formats (Requires ODBC)
* MSG CompuServe message file

* CAB format

* WPS MS Works documents

* SAM AmiPro documents

* OLE 2 compound storage (Requires OLE 2)

* XLS Excel 5

* WKS, WK1-WK4 Lotus 1-2-3

* DOC WordPerfect Documents

* CDR CorelDraw

* PCD PhotoCD

* RTF Rich Text Format

* HTML

* SDB Sidekick database

* MS Backup

* RIFF files

* AVI video files are now played

* Sound is played for Wave (WAV) and Midi (MID, RMI) files
*TTF and FON fonts

* Graphic formats (IMG, CUT, IFF, ICA, LV, MAC, MSP, PSD, PCD, XPM, IM, XBM) (You must be

registered).

* FmView window opens with the right mouse click

* Version of FmView for the Explorer under Windows 95 or Windows NT 4.0
* Menu item to enable mouse and F9 hot key in FmView/Explorer

* Long file name support for Win 95 and NT

* Save all text visible in the viewer as plain text (including hex dumps)

* Convert between all supported bitmap graphics formats



* You can change color depth, orientation, size, for bitmaps (18 different functions)
* Find and replace in edit mode

* Edit mode for text files up to 61k

* Incremental search (text & hex)

* Clipboard support (files, filenames, bitmaps)

* Limited selection of viewing mode

* Font selection

* File info and statistics in a status bar

* Print text and hex dumps

* Selecting directories displays file size and count statistics

* Color coding for INI, BAT, C, CPP, H, RC, PAS, ASM files

* Line numbers can optionally be displayed in text mode (Ctrl+L)

To save viewed text or convert between different graphics formats simply choose Save As....
from the menu. The later works only if you are reqgistered.

What you need to run FmView

FmView requires Windows 3.1x, Windows 95, Windows NT 3.51 and NT 4.0 or better and can
only be activated thru the menu of the Windows File Manager or Windows Explorer.

To view compound document files like WinWord 6 you must have OLE 2 installed on your
system. This is the case if you have any of the products installed whose formats you want to
view, or if you are running Windows 95.

To view any of the data base formats like MDB you must have ODBC installed on your
system. This is the case if you have any of the newer products installed whose formats you
want to view like MS Access. You can also obtain ODBC and the Jet Engine Driver directly
from Microsoft at http://www.microsoft.com. On all versions of Windows install ODBC 2.1
first. In addition to that install ODBC 2.5 or later on Windows 95 and NT.

OLE 2 is available on my support disk.

FmView consists of these files:

fmview.hlp This help file as Windows help and Installation

fmview.cnt Windows help contents

fmview.dll The base DLL (text, hex, Word, Write)

fmvgen.dll Helper DLL (BMP, PCX, WMF)

fmvexe.dll Executable file (EXE, DLL...) conversion

fmvizh.dll LZH conversion. Written by Andi Rosenberg

fmvzip.dll ZIP conversion. Based on WizUnzip by Robert A. Heath. Modified for
FmView by Andi Rosenberg.

fmvarj.dll ARJ conversion. Based on UnArj by Robert K Jung

fmvobj.dll OBJ conversion. Based on ReadObj by Kip Davidson

fmvcis.dll CompuServe Mail Message conversion

fmvhlp.dll WinHelp

fmvcab.dll CAB files

fmvwps.dll WPS MS Works documents

fmvsam.dll SAM AmiPro documents

fmvodbc.dll Database files (dBase, MS Access, FoxPro, Paradox....)

fmvole.dll OLE 2 storage helper (WinWord 6)

ezstg.dll File access helper DLL

fmvhtml.dll HTML. Written by Oliver Besler

fmvmsb.dll MS Backup



fmvrtf.dll RTF files

fmvsdb.dll SDB Sidekick databases

fmvwks.dll WK? Lotus spreadsheets

fmvwpd.dll DOC Word Perfect Documents

fmvwpg.dll WPG Word Perfect Metafiles

fmvxis.dll XLS Excel spreadsheets

fmvpe.dll PE 32-bit executables

fmvwd.dll WD InfoSelect

fmvbit.dll Graphics helper (JPEG, TIFF, GIF, ..) requires registration
fmviewnt.dll FM add-on for Windows NT

fmvdde.dll Stand alone engine

fmvdde3.dll Stand alone engine for NT and 3.1x

fmviewex.dll Explorer addon for Win 95 and NT 4.0

fmviewf9.dll F9 hot key support for Explorer

fmviewx.ini Extension file for FmView (must be in the FmView directory)
courc.fon Small Courier Font

readme.txt ReadMe

fmvinstn.dll Install helper

install.exe Installer for all versions of Windows

Installing FmView

To install just copy all FmView files to your harddisk. And then...

Click here to install FmView now, If you are upgrading from a previous version then you
must restart your system after the installation!

Click here to deinstall FmView now!

Click here to run the File Manager now!
Click here to run the Explorer now!

FmView and its DLLs (i.e. "fmv*.dll") do not belong into the Windows or Windows system
directories. If you have installed your previous version of FmView in your Windows directory,
then you must deinstall and delete these files first before you can upgrade to the new
version.

FmView works on Windows 95, 3.1x, NT 3.51 and NT 4.0.The setup program detects the
platform automatically and sets up the necessary components.

What the installer does and does not do

The installer does not copy any files! Only information is added to INI files and the registry to
hook up FmView to Explorer and File Manager

On Windows 95 and 3.1x the installer adds or removes the line "FmView=fmview.dll" in
the "[AddONs]" section of "winfile.ini".

On Windows NT the installer adds or removes the following entry in the system registry
(regedt32.exe):

HKEY_LOCAL _MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\File
Manager\AddOns\FmView=fmviewnt.dll



On Windows 95 and NT 4.0 these entries are added to the registry:
REGEDIT4

[HKEY CLASSES ROOT\*\shellex\ContextMenuHandlers\FmView]
@="{1DA22F00-D593-11ce-842A-0000C0635A69}"

[HKEY CLASSES ROOT\CLSID\{1DA22F00-D593-11ce-842A-0000C0635A69}]
@="FmView for Explorer"

[HKEY_CLASSES_ROOT\CLSID\ {1DA22F00-D593-11ce-842A-0000C0635A69}\
InProcServer32]

@="FMVIEWEX.DLL"

"ThreadingModel"="Apartment"

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\
FmView]

"DisplayName"="FmView"

"UninstallString"="fmvinstn.dll -d"

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Shell
Extensions\Approved]
"{1DA22F00-D593-11ce-842A-0000C0635A69}"="FmView"

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run]
"FmViewF9"="fmviewf9.dll -1"

Files that FmView generates

These files will be placed in your windows directory along with all other "*.ini" files.

fmview.ini The configuration file
fmview.reg The registration file



Using FmView with File Manager
For Windows 95 and NT 4 see also Using FmView with Explorer.

Using FmView

To use it, simply select a file in the File Manager which contents you want to view and click
with the right mouse button into the File Manager window or press F9. To close the window,
repeat the procedure. The open window will be updated if the selection changes.

FmView can also be invoked by choosing the FmView entry in the FmView menu on the File
Manager menu bar. If you are using Windows for Workgroups 3.1 or higher you can also
press the toolbar button.

The main window of FmView is invoked by selecting any file in the Windows File Manager
and then pressing F9 or by choosing the FmView entry in the FmView menu on the File
Manager menu bar or by clicking with the right mouse button over the File Manager window.

The contents of the file that has been selected will be shown in this main window. Note that
this window stays always in front of the File Manager. You can now select a different file
within the File Manager and the FmView window will be updated accordingly.

You can use the F12 key to quickly switch between the FmView and the File Manager
window. If you press F9 while the FmView window is active, it will be closed. This allows you
to quickly peek into a file by pressing the F9 key to open and close the FmView window.

If you click on an already selected file name in the File Manager, the verbose level of the
shown information will be incremented. This means a more detailed interpretation of the
data will be shown. The same can be done by pressing F5 while the FmView window is
active, or by selecting File|Verbose from the FmView window menu bar. For example on text
files only the first 32k will be read the first time. Clicking on the same file again, reads the
remainder of the file. See File Formats or Main Window and Menus Verbose for details.

File Manager menu extension
These items are also available over an icon in the File Manager toolbar.
FmView

FmView F9
Pops up the main window of FmView.

ClipCopy File [Win 95 and 3.1x only]
Copies the selected file to the Windows clipboard as text.

Copy File Name
Copies the selected file names including the full path to the Windows clipboard as text.
Multiple files are separated by a new line.

Copy Core Name [Win 95 and 3.1x only]
Copies the selected file names excluding the path to the Windows clipboard as text. Multiple
files are separated by a new line.

The following menu entries are only available in grand master mode under Win 95
and 3.1x. (See Advanced Configuration):




Decompress

Decompresses the selected files to the current directory. The files must have been
compressed with the Microsoft compress utility. Most setup disks contain such files, usually
they have a underscore " " as the last character in their extension.

Compact File

OLE 2 compound document files like the files used by WinWord 6 and Excel 5 contain a file
system within a file. This also means that they can get fragmented like hard disks which
slows down access time. They can also contain unused portions, so the file is larger than
necessary. This function defragments and compacts the selected files in a safe manner. No
action is taken on regular files. You must have OLE 2 installed on your system.

Touch File
Allows you to changes the date and time of the selected files. You can enter the them in a
prompter. The default is the current date and time.



Using FmView with Explorer

To use FmView simply select any file in the Explorer window, My Computer, File Selection
Dialog, or the Windows 95 (or NT 4) Desktop with the alternate mouse button. Then select
the FmView menu item from the context menu that appears. This will open up the FmView
window or update the contents in the previously opened FmView window.

FmView also adds a second menu item to the context menu called Copy Name that allows
you to copy the complete file name of the currently selected file to the Windows clipboard.

You can configure FmView so that the F9 function key as well as the middle mouse button
will open the FmView window from Explorer, My Computer and the Desktop. This feature will
not work from File Selection dialogs.

From the FmView Options menu check F9 Key in Explorer. However you must also set the
following options in Explorer or My Computer:

Select Options from the View menu. Select the View tab and then:

Check Display the full MS-DOS path in title bar
Uncheck Hide MS-DOS extensions for files that are registered

If you do not set these options the F9 key will simply not work. If you want to pop up FmView
with the middle mouse button you must have a three button mouse AND a three button
mouse driver installed. For example Logitech mice work with the Standard Mouse driver,
however you must have a Logitech Mouse driver installed to use the middle button.

If you use the feature with the middle mouse button it is recommended that you set the Use
Middle Button option from the FmView Option menu as well. This way you can open and
close FmView with the middle mouse button. The options have been kept separate for
compatibility reasons.

If the F9 key option is set you can also have FmView track the selection in the Explorer
window. Since you can have multiple Explorers and My Computers FmView remembers the
last window from where it was opened (either with F9, context menu, or middle mouse
button click) and it will only track the selection of that window. If you want FmView to track
the selection in another window you must press F9 while that window is active. Note that
you can also have it track the selection in the Desktop.

Explorer Context Menu Items

FmView F9
Pops up the main window of FmView.

Copy File Name
Copies the selected file names including the full path to the Windows clipboard as text.
Multiple files are not yet supported.



Activating the F9 hot key to open FmView from Explorer
To use the F9 key and the middle mouse button to pop up FmView from Explorer, My
Computer, the desktop you must set the following options:

From Explorer or My Computer select Options from the View menu. Select the View tab
and then:

Check Display the full MS-DOS path in title bar
Uncheck Hide MS-DOS extensions for files that are registered

From the FmView Options menu toggle F9 Key in Explorer.

See Using FmView with Explorer for details.




Main Window and Menus
Status Line

The status line on the bottom of the FmView Window contains the following information in
that order:

- Full file name

- Full file length

- Verbose level

- Name of the file format

- Bitmap formats only: width * height * color depth in pixels
- Current activity or error message

Menus
There are two menus. This section describes the menu bar of the FmView main window. For

the FmView menu in the Windows File Manager menu bar see Using FmView with File
Manager. For the Explorer context menu see Using FmView with Explorer.

FmView main window menu
File

Verbose F5

Gives you a more detailed or different representation of the currently selected file. Note that
you can do the same by selecting an already selected file within the File Manager or
Explorer. Don't do that to fast though, because it might result in a double click (See File_
Formats).

New
Clears the FmView window and switches to edit mode, allowing you to create a new text file.

Open...
Pops up a file selection dialog, and allows you to select another file for viewing. This is useful
if you want to use FmView in standalone mode without File Manager (See Advanced

Configuration).

Save
Allows you to save a text file if you have changed it while in the FmView edit mode.

Save As...

Allows you to save a text file if you have changed it while in the FmView edit mode under a
different file name. It also saves any text seen in the Viewer as plain text including hex
dumps. If you are viewing a graphical image (including icons from an ICO, EXE, DLL file) you
can use this menu item to convert it to any other format by selecting the appropriate type in
the file type combo box in the Save as dialog. The later only works in the registered version.

Print...

Pops up a print dialog and then allows you to print the currently viewed text or hex dump. If
you want to format the text then it is recommended that you copy the text to the clipboard
with Edit|Copy and then paste it into a word processor, reformat it, and print it from there.

Process image...
The registered version of FmView allows you to manipulate most bitmap formats. You can
change the color depth, size, orientation and other things. Here's a complete list of the



available operations:

- Increase color depth to 8 bits from 1 or 4 bits

- Increase color depth to 24 bits from 1, 4, or 8 bits

- Reduce to monochrome with Bayer

- Reduce to monochrome with halftone

- Reduce to monochrome with diffusion

- Reduce color depth to 4 bits from 8 or 24 bits with Bayer

- Reduce color depth to 4 bits from 8 or 24 bits with diffusion
- Reduce color depth to 8 bits from 24 bits with popularity

- Reduce color depth to 8 bits from 24 bits with median cut

- Reduce to 8 bit gray scale from 4, 8, or 24 bits

- Flip image around vertical axis

- Flip image around horizontal axis

- Invert bitmap

- Rotate bitmap in 90 degree steps Angle [90,180,270]

- Sharpen image Sharpness [-127..127]

- Change contrast and brightness Contrast [-127..127], Brightness [-127..127]
- Change size Width, Height

- Change size with interpolation Width, Height

Scan...

This pops up the scan dialog for your scanner. You need to have a TWAIN driver for your
scanner installed on your system. If you don't have one, then contact your scanner vendor
for a driver. This feature works only in the reqgistered version.

Close F9
This closes the FmView window. Note that you can use the F9 key to open and close the
FmView window to quickly view a file.

FM F12
Activates the File Manager window. Note that you can use F12 to toggle between the File
Manager and the FmView window.

Edit

Undo Ctrl+Z
Undoes the last change when in edit mode.

Cut Ctrl+X
Deletes text and puts it on the clipboard.

Copy Ctrl+C

Copies text to the clipboard. When in viewing mode, the whole text representation of the file
is copied. In edit mode only the selected text is copied. If you are viewing a bitmap then it
will be copied to the clipboard. (Both as DIB and DDB).

Paste Ctrl+V
Pastes text from the clipboard.

Select All Ctrl+A
Selects all text when in edit mode.

Find/Repl...
This pops up a dialog that reminds you that FmView uses incremental search and that you



can search for text just by typing it while the FmView window has the input focus. F3 finds
the next occurence, F4 the first. ESC resets the search. If you are in the edit mode, you can
search and replace. If you are in hex mode then you can also enter text or press Ctrl+X and
then 2 digits which will be interpreted as a hex value. Note that even then the byte is
treated as case insensitive if this mode is selected in the Options menu, so entering hex 41
will also find hex 61 since this is upper and lower case A.

Go To... Ctrl+G
This prompts you for a decimal line number if you are in text mode and a hex address if you
are in hex mode. The view will then be scrolled to the entered location.

Edit
Toggles between the regular view and the text edit mode of FmView. The current version of
FmView can only edit text files less than 61000 bytes.

View

Auto
Auto detection of viewing mode depending on the selected file's extension and contents.

Hex F8
When checked FmView is forced into hex dump mode regardless of the file contents.

Text F7
When checked FmView is forced into text viewing mode regardless of the file contents.

Bitmap

When checked FmView is forced into bitmap viewing mode regardless of the file contents.
Since this mode should only be set if you know that a file contains a bitmap, it is available
only in grand master mode. You can crash FmView if you don't know what you are doing.
This is most useful for WPG files that contain a bitmap.

OEM F6
Toggles between the ANSI and the OEM character set. The later is useful for viewing files
containing international characters and were created by a DOS application.

Word Wrap

When checked the word wrap is turned on. Lines that are longer than the current window
width will be wrapped to the next line. This feature is available in regular text mode and edit
mode. The current version of FmView breaks lines at 75 characters in text mode.

Line Numbers
This turns on the line number column for text files.

Level O ... Level 5
Selects the verbose level explicitly.

Options

Font...

Allows you to select a font for text representations. The selected font is stored in the
configuration file. For some formats it is advisable to use a font with fixed spacing such as
Courier. You can set two separate fonts, one for hex mode and one for all other text views.

Reduce Font Ctrl+1



Decrements the font size by one point, or the next available smaller size.

Enlarge Font Ctrl+2
Increments the font size by one point, or the next available larger size.

Case Sensitive Search
Toggles between case sensitive and insensitive search. Note that this applies for both text
and hex view.

Play Sounds

When checked, FmView will automatically start playing sound files like wave or MIDI. Videos
will also be played. If turned off only the first frame of the video file will be displayed. You
can start the video by pressing the down arrow.

Color Coding

Turns on color coding for INI, BAT, C, CPP, H, RC, PAS, ASM files. Different sections of the file
will be displayed in different colors to make them more readable. (See Advanced
Configuration on how to change the colors).

Change Palette
When checked, FmView realizes the palette of a bitmap, when it is shown.

Use right button
If checked the right mouse button can be used to open and close the FmView window.

Use middle button

If checked the middle mouse button can be used to open and close the FmView window. You
must have a three button mouse and have an OEM driver for that mouse installed. Changing
this setting on Windows NT requires you to restart your system if you want to use it from NT
File Manager. (Sorry).

ESC Closes Window
When checked the FmView window can be closed by pressing the ESC key.

On Top of FM
If checked the FmView window stays always in front of the File Manager window. Otherwise
the FmView window behaves more like the window of a separate application.

F9 Key in Explorer
Toggles the feature that allows you to pop up FmView from the Explorer with either the F9
function key or the middle mouse button. See FmView with Explorer for details.

Registration...
Pops up the registration dialog. See registration for details.

Help

Contents F1

Opens WinHelp and displays the contents of this help file. You can do the same by pressing
F1.

About FmView...
Shows you the release date and author of the FmView program.






File Formats
These are the file formats that are visualized by FmView. To increment the verbose level click
on the same file again in the File Manager or press F5 while the FmView window is active.

* ASCII/ANSI text
The first 32k will be read on verbose level 0, the full file on verbose level 1.
* Hex
The first 32k will be read on verbose level 0, the full file on verbose level 1.
* WRI Write files
The first 32k will be read on verbose level 0, the full file on verbose level 1.
* DOC MS WinWord
The first 32k will be read on verbose level 0, the full file on verbose level 1.
* DOS Word
The first 32k will be read on verbose level 0, the full file on verbose level 1.
* BMP & PCX bitmaps
* WMF Windows meta files
Must have an APM header, WMF files are basically worthless without one anyway.
*1CO, DLL, EXE icons
On verbose level 0.
* DLL, EXE headers (16 and 32 bits)
On verbose level 1.
* OB files
* ARJ, LZH & ZIP archives directories
* Graphics formats JPG, GIF, TIF, TGA, DCX, EPS, WPG, PCT
You must be registered.
* FXD, FXR, FXS WinFax
Preview on level 0, full image on level 1
* DB, MDB, PDX ... Database formats (Any ODBC compatible format)
First 100 records of each table on level 0, full tables on level 1.
Requires ODBC installed on your system that is included with most major database
applications like MS Access.
* MSG CompuServe message file
* CAB format
* WPS MS Works documents
The first 32k will be read on verbose level 0, the full file on verbose level 1.
* SAM AmiPro documents
* XLS Excel
* WKS, WK1-WK4 Lotus 1-2-3
* DOC WordPerfect Documents
The first 32k will be read on verbose level 0, the full file on verbose level 1.
* CDR CorelDraw
* PCD PhotoCD
You must be registered.
* RTF Rich Text Format
* HTML
* SDB Sidekick database
The overview on verbose level 0, the full database on verbose level 1.
* MS Backup
* RIFF files
* Graphic formats (IMG, CUT, IFF, ICA, LV, MAC, MSP, PSD, PCD, XPM, IM, XBM)
You must be registered.
* AVI video files are now played when selected
Use the cursor keys to control the video flow:
left & right for single step; up & down for continuous play
* Sound is now played for Wave (WAV) and Midi (MID, RMI) files



* TrueType TTF and FON fonts are now displayed without installing

* MS Access 7

* WD InfoSelect

* Selecting directories now displays file size and count statistics. Press F5 for recursive
statistics

* Optional color coding for INI, BAT, C, CPP, H, RC, PAS, ASM files

The following formats are recognized and their name is shown in the status line (See below
for footnote explanation):

Ami Pro Document
Amiga IFF [2]

ARJ Archive
Assembler Source
AVI Video [12]

Basic Form

Basic Source

Binary

C Source

CAB archive
Calender [1]

CALS Bitmap [2]
Card [1]

CIM Keyfile

CIS Mail [7]
Clipboard [1]
Compiler Object
Configuration File
Corel Draw [5]
dBase Data Base [4]
DCX Bitmap [2]
Document

Dynamic Link Library
Encapsulated Postscript [2][5]
Excel 3

Excel 4

Excel 5 [3]

Fax [8]

Font

Fortran Source
FoxPro Data Base [4]
GEM Bitmap [2]

GIF Bitmap [2]

Halo CUT Bitmap [2]
Help

HTML Document
Icon

InfoSelect

IOCA Bitmap [2]
JPEG Bitmap [2]
LaserView Bitmap [2]
Linear Executable [1]
Linker Definition
Lotus 123



LZH Archive

MacPaint Bitmap [2]
Make File

MIDI [11]

MS Access Data Base [4]
MS Paint Bitmap [2]

MS Works

MS Works 3 [3]

MS Works for DOS
MSDOS COM [1]

MSDOS Command Batch
MSDOQOS Executable

New Executable

NT Executable

OLE 2 Compound Document [3]
Paradox Data Base [4]
Pascal Source

PCX Bitmap

Photo CD Bitmap [2]
Photoshop Bitmap [2]
PICT Bitmap [2]

Pixmap Bitmap [2]
Program Manager Group [1]
QuickHelp [1]

Resource Binary [1]
Resource Source

Rich Text Format

Rich Text Format [6]
RIFF [1]

Sidekick Data Base

Sun Bitmap [2]

TARGA Bitmap [2]

TC Desktop Config [1]
TC Project [1]

Text

TIFF Bitmap [2]

TKB Fridge [1]

TKB Registration [1]
True Type Font

Wave Sound [10]
Windows Bitmap
Windows Meta

Windows Program Information [1]
WinFaks [8]

WinHelp

WinWord 1 Document
WinWord 2 Document
WinWord 6 Document [3]
Word Perfect Document
Word Perfect Graphics
Word Perfect Metafile
Write

X Bitmap [2]

ZIP Archive

Z0OO0 Archive



[1] Description only. Representation will be hex dump.

[2] Requires registration.

[3] Requires OLE 2 installed on your system that is included with most major applications
like WinWord. OLE 2 is also included with Windows 95.

[4] Requires 16 or 32 bit ODBC installed on your system that is included with most major
database applications like MS Access.

[5] Preview bitmap only

[6] Raw format only

[7] Mail messages only

[8] Preview bitmap only. Full view requires [2]

[9] Requires 32 bit ODBC and MS Jet Engine installed on your system that is included with
most major 32 bit database applications like MS Access 95.

[10] Requires sound card or PC Speaker sound driver

[11] Requires sound card

[12] Requires Video for Windows installed. Included with Windows 95



Advanced Configuration

You can turn FmView in a stand alone program if you copy the file "fmvdde.dll" to the file
"fmvdde.exe". (On Win 3.1x and NT copy the file "fmvdde3.dll"). You can then run this from
any program launcher. You can also pass a file name as a command line argument. This file
will then be opened for viewing.

There are a couple of FmView options which can only be changed by editing the "fmview.ini"
file directly. There is no user interface for those because there is usually no need for them to
be modified, but it might come in handy for you to change them.

After you have changed the configuration file, just close the File Manager and open it again
for the changes to take effect.

These options are in the "[FmView]" section of "fmview.ini":

1*¥1=1

To turn on the grand master mode you must write "1*1=2" (sic). This gives you three extra
menu items (Touch, Decompress, and Compound Compact ) in the FmView menu in File
Manager and it enables the View|Bitmap menu item. Only enable this mode if you know
what you are doing.

MenuTitle=FmV&iew
Specifies the menu title as it appears in the File Manager. The character that follows the
ampersand will be used as accelerator key.

FMToolbar=1
Turns off the toolbar icons that are available in the File Manager.

ActivateFM=0

If set to 1 the File Manager window will be activated when the FmView window is closed.
Otherwise the window that was active before FmView was activated will be active. This may
sometimes seem unnatural.

AddFont=1
If set to 1 then FmView install the "courc.fon" if it has not already been installed.

Hook=1

When set to 0 FmView will not intercept File Manager messages. Use this ONLY IF you have
trouble with other utilities that use this method. You will loose the ability to operate the
FmView accelerator keys, the keyboard support in the replace dialog, and the right mouse
button quick open.

IgnoreDownSelect=1

A value of 1 ignores the file select events if the left mouse button is pressed. This is
necessary to compensate a bug in the Norton Desktop for Windows. A value of 0 turns off
this fix.

MultiFonts=1

Setting this option to 1 turns of the separate font for hex. Only one font will be used like in
FmView versions earlier than 1.3.

LineNumber=0
A value of 1 turns on line numbers by default.

LineNumberBase=1



This is the base at which the line number count starts. The only other sensible value is 0.
(Some might say the only sensible value)

ColorSection=0,0,128
This is the RGB value that will be used for emphasized parts of a color coded file like
sections in INI file and function declaration in C and Pascal. The default is dark blue.

ColorComment=0,128,128
This is the RGB value that will be used for comments in color coded files like C, CPP, H, RC
PAS, BAT and INI. The default is dark cyan.

ColorPrep=0,128,0
This is the RGB value that will be used for pre-processor directives in C, CPP, H and RC files.
The default is dark green.

WordWarp=0
A value of 1 turns on word wrap by default.

SunkenLook=1
On Windows 95 and NT 4 a value of 0 in this place allows you to turn off the neat 3D look of
the FmView main window.

Win95Help=1

On Windows 95 and NT 4 a value of 0 in this place allows you to pop up the plain help
window instead of the help contents dialog (help finder). A value of 1 always forces FmView
to use the new help.

ExplorerWideChar=1
This determines whether UniCode should be used in the menu item description.

ExplorerCheckMouse=1
Determines whether the Explorer add-on checks for the middle mouse button to pop up the
FmView window.

MenuTitleExplorer=&FmView
The ampersand indicates that the following character will be used as accelerator key. You
can also change the title for the Copy Name entry. (See below).

MenuTitleExplorerCopy=Cop&y Name
You can make the item disappear completely if you specify an empty string.

UseFmViewPathForDLLs=1
If set to 1 the path name of the "fmview.dll" will be prefixed to all other DLLs. Otherwise the
DLLPath will be used.

DLLPath=
Contains the path that should be used to locate the DLLs.

These options are in the "[DLLs]" section of "fmview.ini":

<DIIFile>=<DIIFileWithFullPath>
This section contains entries in the above format. If an entry exists in this section, it
overrides all other DLL path options. For example:



fmvobj.dll=c:\fmview\fmvobj.dll

The file "fmviewx.ini" located in your FmView directory contains settings that allow
additional file formats to be installed into FmView without changing any of the existing
program components. The format of the file is documented as comment in the file itself. The
API of the filter DLLs is available for developers. You can easily install new ODBC data base
formats. If you are an experienced user, the comments in the ini file should be sufficient for
now.

Hidden Features
Holding down the control key while choosing File|Close unloads FmView from memory.

You can chance the number of characters per line used for the internal word wrap during this
session. In the Go To... dialog box prefix the number with an asterisk (*) character.

On Windows 95 you can hide the desktop icons "My Computer", "Network Neighborhood",
and "Recycle Bin" that cannot normally be removed from your desktop. To do that run
RegEdit and add the -i switch to the already present - switch in this location:

[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run]
"FmViewF9"="fmviewf9.dll -I"



Credits
FmView was written by Dieter Prifling. See registration for details.

This program is dedicated to my wife Martina.

The author would like to thank all the guys at The Knowledge Base (Andi, Ansgar, Hans,
John, Peter & Wolfgang) as well as Oliver, Andy, Dave, Walter, Hans and Herman for
inspiring some of the ideas and for using FmView in their daily work and thus participating in
the beta test for this product.

Special thanks go to Andi for writing the LZH FmView add-on and getting the ZIP add-on to
work, and to Oliver for doing all the e-mail handling.

We also like to thank Robert K Jung, Robert A. Heath, Pete Davis, and Kip Davidson
for making their source code available. Made our job a little easier.

Portions of the image technology used in the registered version of FmView are copyrighted
by AccuSoft Corporation.



Registration

Why should | register and what do | get for it
How do | register and what does it cost
Where can | get in touch with you

Legal stuff
REGISTRATION FORM




Why should | register and what do | get for it

The right to use the software

Just because you already have this program on your disk does not give you the right to use
the software. You can try FmView for 30 days but after that you must either discontinue to
use it and remove it from your hard disk or you must register your copy. If you do not do
either of these things, you are breaking the law.

Moral obligation

Another reason why you should register if you use FmView over a trial period is because it is
the morally correct thing to do. A lot of additional effort was necessary to turn FmView in a
more professional product and make it available to a larger number of people. (For example
this help file). If there is not enough response to acknowledge this work then future versions
and programs developed by this author will not be distributed thru shareware.

Peace of mind

The unregistered version of FmView has almost the full functionality of the registered
version. To remind you to register, the caption of all windows contains in addition to their
regular title "Unregistered Copy".

After every 10 viewed files the FmView Window will show "Unregistered Copy" for 5 seconds.
A reminder dialog will pop up twice a month asking you to register.

Support and upgrades

Registered users will receive free support thru e-mail. Other forms of communication remain
free as long as they are kept within a reasonable relation to the registration fee. Registered
users will be notified when the next release that contains significant improvements is
available. The authorization number that registered users receive, will work with upgrades.
The author reserves the right to ask for an additional payment for upgrades when the major
version number changes, or to enable additional features. (The author doesn't believe in
incrementing version numbers that fast, so rest assured). (See The Future for details).

Upgrades are available on CompuServe usually in the WINSHARE forum, or on
http://users.aol.com/OliverBes/DPWare/dpware.htm. This are the only places that are
guaranteed to be updated directly by the author. Other BBS systems or disks from
shareware distributors (from where you have obtained this copy for example) will usually
carry the upgrades. But please understand that this can not be guaranteed by the author.

Upgrades can also be ordered directly from the author on 3.5" disk by sending in the filled
out order form. This support disk contains lots of other programs as well. Please note that
the author reserves the right to distribute some components only directly on disk and not
thru other methods. This is usually due to distribution restrictions of licensed components.



How do | register and what does it cost
Method
To register you have to send your full name, address and phone number.

To make it easier a registration form has been provided.

The registration fee is 25 DM (deutsche mark) or 15 US$.
Within Europe you can send a EuroCheque (please use the German currency DM).
From the United States you can send any regular check in US$.

Worldwide you can pay with VISA Card, MasterCard, EuroCard and Access (please
include your card number, expiration date and signature (mail or fax) and state that you
wish to pay 25 DM), or you can send any check in US$ drawn to a US bank, DM check drawn
to a German Bank. If you are sending traveler checks or cash you are doing so at your own
risk.

You can also register by using the CompuServe registration service. The registration fee will
then be charged to your CompuServe account. Just GO SWREG. The program ID for FmView
is 3610. You will be asked for your address. Please do not leave the phone number blank.
Your account will be charged with US$29 which includes the price for the support disk and
the 18% CompuServe processing fee.

Here is a table for the postage necessary to send a business letter from your country to
Germany at the time of writing. Call your post office just to make sure the prices are still up
to date.

Country Stamp

U.S.A. 60 cents (up to .5 0z); 100 cents (up to 1oz)
Canada 88 cents

Great Britain 25 p (up to 209); 42p (up to 409)

Eire 32 p

Netherlands 80 ct

All information that is submitted will be treated confidentially and will not be given or sold to
a third party.

After a short time you will receive your authorization number. You have to enter your
personal data as well as this number accoding to the instructions that you will receive.
Please enter this information exactly as you have received it character by character. FmView
will use this data to verify the authorization number. Note that you must restart FmView to
make your registration effective. If you still get the register reminders, check the information
that you have entered.

Your personal data will be saved in the "fmview.reg" file. This file must not be given to
anyone.

You are encouraged to give FmView to all your friends or distribute it thru mail boxes. Be
sure that you include all files as received.

If you have received "fmview.reg" in response to your registration request (for example over
e-mail), you don't have to key them in, just copy "fmview.reg" to your Windows directory.



Note that the registration is only valid for one user. Please inquire details for a license for
more users.



Where can | get in touch with you
If you are registered or not, your feedback is very important to me, so send in your
comments and suggestions for improvement.

Electronic mail:

CompuServe 100012,3651
Internet 100012.3651@compuserve.com

Check out http://users.aol.com/OliverBes/DPWare/dpware.htm
Mail address:

Dieter Prifling

Postfach 1532

93070 Neutraubling

Germany

Fax:

+49 9401 79531 (within Germany (09401) 79531) or you can't get thru:
+49 9482 3249 (within Germany (09482) 3249)

Replace the plus sign with your country's international access code. For example from the
United States this code is 011 so you have to dial 011 49 9401 79531 to send me a fax.

Phone:

If and only if you don't have access to e-mail services or a fax and mail is to slow for your
urgent questions, you can call me directly on weekdays during the day (Central European

Time, (EST + 6 hours)).

Dieter Prifling
Phone: +49 9482 2832 (within Germany (09482) 2832)

You can talk to me in German or English.

If you wish to pay with direct bank transfer my account number is:

Country: Germany

Bank: Sparkasse Regensburg
Bank code (BLZ): 750 500 00

Account#: 503 4707

Click here for the reqgistration form




Legal stuff
By using this product you are accepting the following terms regardless of local law.

This software and documentation is provided "as is" without warranty as to their
performance, merchantability or fitness for any particular purpose. In no event shall the
author or anyone else who has been involved in the creation, production, or delivery of this
software be liable for any direct, incidental, or consequential damages, such as, but not
limited to, loss of anticipated profits, benefits, use, or data loss resulting from the use of this
software, or arising out of any breach of any warranty.

In short: You are using FmView at your own risk and the author may not be held responsible
in any way for any damage of any kind caused by this program.

Using an unregistered version of the product for more than 30 days is prohibited.

With a single user license this product can be installed on all machines that the registered
person personally uses most of the time, as long as only ONE person is using the installed
copies of the program at a given time. In all other cases a multi user license is needed.

A valid multi user license must show the maximum number of users in the name field of the
registration. With this license form no more then the maximum users allowed must use the
software at a given time. With the exception of private multi user licenses, the software can
only be installed on machines that are located most of time within ONE contiguous area
occupied by the company or organization which is named in the registration.



Registration form

Click here to print this form now!. OR
Click here to copy this form to the clipboard and open Write. Then press Ctrl+V to paste this form from the clipboard
into Write. Fill it out and print it, or save it as plain text and send it to me as e-mail.

Send it to: Check out http://users.aol.com/OliverBes/DPWare/dpware.htm

Dieter Prifling Fax: +49 9401 79531 [or +49 9482 3249]

Postfach 1532 (for example from the United States dial 011 49 9401 79531)
93070 Neutraubling CompuServe: 100012,3651

Germany Internet: 100012.3651@compuserve.com

Registration and order form for FmView

If checked, | want:

() To register FmView 1.3 at the cost of 25 DM (or 15 US-Dollars) for a single user license. | will receive an
authorization number to switch FmView to its regular mode of operation. In addition | will be eligible for support
and my authorization will work with upgrades at least up to the next major version number. Also | will be
notified when the next release that contains significant improvements is available.

| will not give my authorization number or the contents of the "fmview.reg" to a third party. All information that |
submit will be treated confidentially and will not be given or sold to anyone.

() To inquire about the cost of multi user licenses (huge discounts apply).
Number of users:

() To be sent the printed documentation for the current release for 15 DM (or $10) incl. p&p.
() in English

() To be sent a disk that contains FmView as well as other shareware programs for 15 DM (or $10) incl. p&p.
() immediately.
() when the next release is available.

First & last name:
Company (optional):
Street:

City & post code (ZIP):
Country:

Phone:

Electronic mail address (if available):
Fax number (optional):

Method of payment:
() VISA Card, MasterCard, EuroCard or Access
Card number:
Expiration date:
() EuroCheck
() Check in US$ drawn to a US bank
() Check in German currency drawn to a German bank
() CompuServe registration service
(GO SWREG, ID: 3610, US$29 incl. disk & CIS fee)
() Bank transfer (within Germany free, outside Germany please add 30 DM bank fee)
() Traveller check or cash

Signature (if mail or fax registration):



Other Products
All released products are available on the support disk. (See registration form).

FmLfns

FmLfns (File Manager Long File Name Support for Windows 95) brings back the good old File
Manager to Windows 95. It upgrades the File Manager so that it displays and completely
handles long file names. (for example "proga~1" becomes "Program Files").

WinDrop

WinDrop is a drag & drop program launcher for Windows in the form of an icon bar. It lets
you assigh system wide hotkeys to your apps and has a lot of additional features, including
saving the last window position of any program, a clipboard doubler, clock, reminder, CD
player control, and it can stick to the File Manager. It can be used as full Program Manager
replacement. It also supports remote execution with NDDE, MS-Mail, and has an extensive
online-help.

FmView

FmView is a Explorer and File Manager add-on. It can display the contents of the currently
selected file. It opens on a single mouse click and automatically determines the file format
and selects an appropriate representation. FmView works with Explorer for Window 95 and
NT 4.0 as well as under File Manager for Windows 95, Windows 3.1x, Windows NT 3.51 and
NT 4.0. Here are some of the 70 representations that have been implemented so far:

* ASCII text

* ANSI text

* Hex

* WRI Write files

* DOC MS WinWord

* DOS Word

* BMP & PCX bitmaps

* WMF Windows meta files

*1CO, DLL, EXE icons

* DLL, EXE headers

* OB files

* ARJ, LZH & ZIP archives directories

* Graphics formats JPG, GIF, TIF, TGA, DCX, EPS, WPG, PCT (You must be registered).
* FXD, FXR WinFax

* XLS Excel 4

* DB, MDB, PDX ... Database formats (Requires ODBC)
* MSG CompuServe message file

* CAB format

* WPS MS Works documents

* SAM AmiPro documents

* OLE 2 compound storage (Requires OLE 2)
* XLS Excel 5

* WKS, WK1-WK4 Lotus 1-2-3

* DOC WordPerfect Documents

* CDR CorelDraw

* PCD PhotoCD

* RTF Rich Text Format

* HTML

* SDB Sidekick database



* MS Backup

* RIFF files

* AVI video files are now played

* Sound is played for Wave (WAV) and Midi (MID, RMI) files

*TTF and FON fonts

* Graphic formats (IMG, CUT, IFF, ICA, LV, MAC, MSP, PSD, PCD, XPM, IM, XBM) (You must be
registered).

* FmView window opens with the right mouse click

* Version of FmView for the Explorer under Windows 95 or Windows NT 4.0
* Menu item to enable mouse and F9 hot key in FmView/Explorer

* Long file name support for Win 95 and NT

* Save all text visible in the viewer as plain text (including hex dumps)

* Convert between all supported bitmap graphics formats

* You can change color depth, orientation, size, for bitmaps (18 different functions)
* Find and replace in edit mode.

* Edit mode for text files up to 61k

* Incremental search (text & hex)

* Clipboard support (files, filenames, bitmaps)

* Limited selection of viewing mode

* Font selection

* File info and statistics in a status bar

* Print text and hex dumps

* Selecting directories displays file size and count statistics

* Color coding for INI, BAT, C, CPP, H, RC, PAS, ASM files

* Line numbers can optionally be displayed in text mode (Ctrl+L)

FmExtMan

FmExtMan (File Manager Extension Manager) is a File Manager add-on. It allows you to add
more than the 4 add-on DLLs that File Manager limits you to. All top level menus are put into
one menu as submenus, so your File Manager menu is not clogged up. FmExtMan has a
dialog that lets you change, reorder, install & deinstall not only its own, but also the top level
File Manager extensions. You can quickly park and reinstate add-ons and toggle whether
they show up in the menu bar or a submenu. The toolbar is supported.

MySound

MySound allows you to assign your favorite Windows wave files (*.wav) individually to the
sound made by any application. No more boring default sounds. You can also shut up any
overbeeped application.Version 2.0 now includes an easy to use user interface. It just takes
three mouse clicks to change the sound or beep you have last heard to a different one, or to
turn it off completely.

DigDrop

Dialog Drop allows file drop in all edit fields and file dialogs

DirAll

Produces text files that list the full directory of disks (floppy & hard). Lots of sorting criteria
(within one disk or across multiple disks), verification and cross reference across multiple
disks. Can be used to find file duplicates even if the file names and time stamps are

different, and thus revive valuable hard and floppy disk space. Works in the background as
well.



Shouter for Windows for Workgroups

Lets you broadcast messages to any number of WfW users. Shouter will automatically be
launched on the remote machine. It's like a cross between Chat (only one partner) and MS-
Mail (only slow notification). It's best suited to notify more users immediately. Shouter lets
you even send the same message as mail, "shout" it or both. It keeps a history of all sent
and received messages.

ShowPar

Small utility to show you all kinds of parameters, directory, & much more.

WWaitNGo

Windows Wait and Go lets you run applications on a during startup after confirmation or

timeout. You can even select the application you want to run in Windows from your MS-DOS
6 boot menu.



What's new
Features marked with * work only if you are registered.

Check out FmLfns (File Manager Long File Name Support for Windows 95)

For the latest version check out: http://users.aol.com/OliverBes/DPWare/dpware.htm
Release 1.3

New File Formats

- AVI video files are now played

- Sound is now played for Wave (WAV) and Midi (MID, RMI) files

- TrueType TTF and FON fonts are now displayed without installation

- Word Perfect 6 format

- MS Access 7

- Selecting directories now displays file size and count statistics. Press F5 for recursive
statistics

- Optional color coding for INI, BAT, C, CPP, H, RC, PAS, ASM files (menu item)

- WINZIPSE files

- 32-bit executable PE format

- InfoSelect format

Other Features

- Menu item for process image (Ctrl+B). You can change color depth, orientation, size, and
other adjustments (18 different functions) *

- Better Save as options for image formats: Compressed/Uncompressed *

- Version of FmView for the Explorer under Windows 95 or Windows NT 4.0

- Menu item to enable mouse and F9 hot key in FmView/Explorer

- New Windows 95 look on Windows 95 and NT 4.0 (3D dialogs and main window, thin fonts
in dialogs)

- No more flicker when the FmView window is resized. (This was especially annoying when
MS Plus option "Show window contents while dragging" was checked).

- Complete long file name support for Win 95 and NT (Check out EmLfns 95)

- Case preserving display of file names unless all uppercase

- Long file name in file open and save dialog on Win 95

- Line numbers can optionally be displayed in text mode (Ctri+L)

- Cursor keys for AVI: left & right for single step; up & down for continuous play

- Windows meta files can now be read even if they do not have an APM header

- Ratio is preserved when viewing Windows meta files

- ODBC now works with 16 and 32 bit drivers

- Hex font and text font can be set separately

- Fonts size increase/decrease commands now work in points and choose the next available
larger/smaller size

- FmView window pops up on releasing the mouse button instead of depressing it

- Word wrap is remembered during one session

- Case insensitive search option (hex and text)

- ESC to close FmView window (optional)

- New Select All menu item Ctrl+A

- New Undo menu item Ctrl+Z

- Ctrl+G Accelerator for Go To...

- Ctrl+E Accelerator for Edit|Edit

- Help is updated for Win 95 and NT 4

- Pressing F1 now pops up the help

- The help file closes when FmView is closed

- Switching to edit mode automatically reads in the entire file



- FmView menu item Touch allows you to enter a time stamp [grand master mode]
- FmvDde now has an icon

- Error message if insufficient memory

- FmView has been prepared for localization

Fixes and improvements on old features

- HTML problems when viewing newer versions of the files are fixed

- Viewing certain BMP files in verbose mode 1 is fixed

- Fix for ODBC GPF when ODBC was not correctly installed

- Improvements on WKS filter

- XLS now recognizes password protected files

- RTF \line command is now displayed correctly

- Improved WordPerfect 5 support

- Minor bug fixes for selection redraw and scrolling with tabbed text

- Horizontal centering during search now uses pixel coordinates instead of characters

- When FmView always on top is on, all of it's message boxes are now always on top as well
- FmView/Explorer no longer switches Explorer into Rename mode on Copy Name menu item
- Status bar message is now displayed properly by FmView/Explorer under Win NT 4.0

- You can now switch into edit mode if word wrap is on

- Zero length file can now be edited

- Accelerator key in File menu &Close changed to C&lose to avoid conflict with S&can

Release 1.2

New File Formats

- Excel 5

- Lotus 1-2-3 WKS, WK1-WK4 files
- WordPerfect Documents

- WordPerfect Graphics Metafile

- MS Works 3 Documents WPS

- CorelDraw

- PhotoCD *

- Rich Text Format RTF

- HTML

- Sidekick database

- MS Backup

- RIFF files

- Graphic formats (IMG, CUT, IFF, ICA, LV, MAC, MSP, PSD, PCD, XPM, IM, XBM) *

Other Features

- Scanner support (requires Twain driver) *

- Search in hex mode, both strings and hex patterns (Hex by pressing ~X and 2 hex digits)
- Word wrap with text files Ctrl+W

- Menu item for "go to" line number in text mode or hex address in hex mode

- Any text in the FmView window can now be printed including hex dumps.

- Copy bitmaps to the clipboard

- Copy multiple filenames to the clipboard

- Convert icons from ICO, EXE, DLL to any bitmap format *

- For bitmaps the width, height, and color depth is now shown in the status line

- EXE file that accepts a file as a parameter and then open a standalone FmView window.
- File Open... menu item

- FmView window remembers its maximized/normal state

- Automatic horizontal scrolling during incremental search

- Confirmation for copying large files to the clipboard



- Ctrl+S for save
- First Windows NT version of FmView

Release 1.1

New File Formats

- WinWord 6

- Excel 4

- Database files (dBase (DBF), MS Access (MDB), Fox Pro, Paradox ....) (requires ODBC)
- Graphic formats (JPG, GIF, TIF, TGA, DCX, EPS, WPG, PCT) *

- WinFax files

- WinHelp

- CAB archives (New compressed files for setup disk from Microsoft)

- WPS MS Works documents

- SAM AmiPro documents

Other Features

- FmView window opens with a right mouse click

- Save all text visible in the viewer as plain text (including hex dumps)

- Convert between all supported graphics formats *

- Find and replace in edit mode

- FmView can optionally be overlapped by the File Manager

- OEM text toggle works

- Word wrap in edit mode

- Decompresses setup files

- Compacts and defragments OLE 2 files like WinWord 6 DOC files

- Clearer viewing mode selection

- New ZIP formats are recognized

- ZIP converter now works correctly with files containing banners

- FmView now works even with the buggy prerelease of the Windows File Manager from the
Sparta project (winfile.exe size: 182848 dated: 1992.04.03).

- FmView now compensates bugs in the Norton Desktop for Windows

Release 1.0

Initial release.



Deutsch (German)
FmView ist ein AddOn flr den Windows Dateimanager oder Explorer. Es zeigt Ihnen in einem
separaten Fenster den Inhalt der gerade im Dateimanager angewahlten Datei an.

FmView funktioniert mit Explorer unter Window 95 und NT 4.0, sowie File Manager unter
Windows 95, Windows 3.1x, Windows NT 3.51 und NT 4.0.

Zur Installation einfach alle Dateien in ein Verzeichnis kopieren und "install" im Inhalt dieser
Hilfestellung anklicken. Danach ist FmView Uber das Dateimanager MenU oder Uber die F9
Taste, oder im Explorer Context Menu verflgbar.

Dateiformate.
Registrierung

Wenn Sie an FmView Gefallen finden, sollten Sie sich fir 25 DM registrieren lassen. Sie
erhalten Unterstitzung und werden Uber das Erscheinen neuer Versionen benachrichtigt.
Uberweisung, EuroScheck und Kreditkarten (VISA Card, MasterCard, EuroCard und Access)
werden akzeptiert. AuBerdem stellen Sie damit sicher, dal8 der Autor weitere Programme
Uber diese unburokratische Methode vertreibt. Nach einer Probezeit von 30 Tagen mussen
Sie sich registrieren lassen oder das Programm von Ilhrem PC entfernen.

Es gibt ein Bestellformular, das Sie ausdrucken oder editieren und an mich senden kénnen.

Egal ob Sie sich registrieren lassen oder nicht, Ihr Kommentar und lhre
Verbesserungsvorschlage sind stets erwlnscht.

Elektronisch (E-Mail):

CompuServe 100012,3651
Internet 100012.3651@compuserve.com

Post Adresse:

Dieter Prifling

Postfach 1532

D-93070 Neutraubling

Fax:

Faxnummer:

+49 9401 79531 (in Deutschland (09401) 79531) oder
+49 9482 3249 (in Deutschland (09482) 3249)

Telefon:

Wenn und nur wenn Sie keinen Zugang zu den E-Mail Services und kein Fax haben und es zu
dringend ist, um den Postweg zu benutzen, kénnen Sie mich notfalls auch anrufen:

Dieter Prifling
Telefon: +49 9482 2832 (in Deutschland (09482) 2832)

Nennen Sie bitte lhren vollen Namen, Privatadresse, Telefonnummer, und wahlweise Firma.



Sie erhalten dann eine Autorisierungsnummer, die Sie nicht weitergeben durfen.

Meine Bankverbindung in Deutschland lautet:

Bank: Sparkasse Regensburg
BLZ: 750 500 00
Konto#: 503 4707

Weiteres entnehmen Sie bitte dem Bestellformular. Der englische Orginaltext ist
Rechtsgrundlage.

Viel Spaf!



Bestellformular

Klicken Sie hier, um dieses Formular jetzt zu drucken!. ODER
Klicken Sie hier, um dieses Formular in die Zwischenablage zu kopieren und Write zu starten. Dann dricken Sie
Strg+V, um dieses Formular einzufligen. Flllen Sie es aus und drucken es, oder speichern es als ASCIl Text und

senden es mir Uber e-mail zu.

Schicken Sie es an:

Dieter Prifling Fax: 09401/79531 [oder 09482/3249]
Postfach 1532 CompuServe: 100012,3651
D-93070 Neutraubling Internet: 100012.3651@compuserve.com

Bestellformular fir FmView

Wenn angekreuzt, dann will ich,

() FmView 1.3 fir 25 DM registrieren lassen. Ich bekomme dann eine Autorisierungsnummer flr einen Benutzer,
um FmView in seinen normalen Arbeitmodus zu schalten. AuBerdem erhalte ich Unterstitzung und Beratung
sowie eine Benachrichtigung beim Erscheinen einer neuen Version welche signifikante Neuerungen enthalt. Die
Registrierung ist mindestens gultig bis zur Erh6hung der Hauptversionsnummer.

Ich werde meine Autorisierungsnummer und den Inhalt des "fmview.reg" keinem Dritten Uberlassen oder
zuganglich machen. Alle meine Angaben werden vertraulich behandelt und an niemanden weitergegeben oder
verkauft.

() Informationen Uber die Preise einer Lizenz fir mehrere Benutzer. (GroRzligige Vergunstigungen)
Anzahl der Benutzer:

() die Dokumentation auf Papier fir 15 DM inkl. Porto/Verp.
() in Englisch

() eine Diskette mit FmView und anderen Sharewareprogrammen zugesandt bekommen fir 15 DM inkl.
Porto/Verp.
() sofort.
() nach dem Erscheinen einer neuen Version.

Vor- & Nachname:
Firma (freigestellt):
Strale:

PLZ & Stadt:

Land:

Telefon:

Electronic Mail Adresse (falls verflugbar):
Fax Nummer (freigestellt):

Zahlungsweise:

() VISA Card, MasterCard, EuroCard oder Access
Kartennummer:
Glltig bis:

() Euro-Scheck

() Verrechnungsscheck

() BankUberweisung

() CompuServe Registrierservice
(GO SWREG, ID: 3610, US$29 incl. disk & CIS Geblihr)

Unterschrift (bei Post oder Fax Registrierung):









